FMA

Direct

Flight Systems

including the
FS Receiver for Aircraft
and
FS Receiver Viewer Software



Getting started

Everything you need to know about the FS Receiver and the FS Receiver Viewer Software is provided in
these pages.

The FS Receiver offers unique features not found in other receivers. It's not complicated, but you will need
to learn a few new concepts and procedures before you can use the receiver effectively.

Start by reviewing the features available in the FS Receiver and its companion Viewer Software. Then work
your way through the topics as they are listed in the contents (the "Previous" and "Next" buttons at the
bottom of each page take you through all topics in sequence).

Tip: Take time to learn how the FS Receiver operates. Work with it on

the bench, before you install it in your aircraft.

"But | don't like to read instructions!"”

Okay, but you have to read a few. Condensed instructions are provided in ES Receiver quick start and
Viewer Software quick start.




Features

FMA's Flight System products protect your investment before you take off, while you're flying, and after you
land.

FS Receiver for Aircraft

m Universal operation: works with both negative shift (Futaba, Hitec) and positive shift (JR, Airtronics) PPM
transmitters.

For aircraft (72MHz) installations.

m Full range, full performance. Can be used in aircraft ranging from park flyers to IMAA-legal aircraft to
helicopters.

m Frequency-Clear feature tells you whether another transmitter is using your channel.

m Digital Signal Recognition eliminates nearly all interference (see How the FS Receiver works).

m Set any channel for a failsafe position using your transmitter (see Setting up the FS Receiver).

m On loss of signal, failsafe channels move to preset positions, other channels hold last good frame
position (see About FS Receiver modes).

m LED blinks battery voltage, number of failsafes and number of bad frames received.

m Better range checking: receiver records signal loss (if any) during range check, then displays result (see
Checking radio system range).

m Includes remote button/LED for programming and feedback from outside aircraft.

FS Receiver Viewer Software

m Real-time display of FS Receiver data (see Using the Viewer Software).

m Graphically shows servo positions for all channels.
m Graphically shows failsafe preset positions.
m Built-in recorder/player: record receiver data, play back for analysis, add notes.

m Unique Help Wizard describes exactly what receiver is doing, and interprets receiver data for you (see
Using the Help Wizard).

m Runs on PCs having Windows 98 or later and a serial port.

m Use with a laptop computer for radio system analysis at your flying field.

Note: The Viewer Software is not required for FS Receiver setup and
operation, however, it is a great tool for helping you set up a FS
Receiver. It provides a convenient way to view and interpret what the
receiver is doing, and permits data recording and playback.

Note: The Viewer Software requires the FMA Interface Module to
display and record data from the FS Receiver.



Safety precautions

Radio controlled models are not toys! Please observe these general safety precautions:

Follow all instructions provided here to assure safe operation.

If you have not assembled and operated a radio controlled model before, obtain help from an
experienced modeler. You will need guidance to successfully assemble, test and operate radio
controlled models. One of the best ways to obtain help is to join your local radio control club.

Never fly radio controlled aircraft near people, buildings, telephone or power lines, cars, trees or other
objects on the ground or in the air.

Never allow a helicopter to fly within 20 feet of you or another person. If a helicopter flies toward you or
another person, stop the engine immediately to prevent personal injury.

Keep your radio controlled models and equipment away from children. Do not allow unauthorized people
of any age to operate radio controlled models without proper supervision from an experienced modeler.

In some areas of the country, you cannot legally operate radio controlled models except at approved
fields. Check with local authorities first.

Observe frequency control. If someone else is operating a radio controlled model on the same channel
as your transmitter, do not turn on your transmitter—even for a short time. Your transmitter has a
channel number marked somewhere on its case. When a model receives signals from two
transmitters on the same channel at the same time, it cannot be controlled and will
crash—possibly causing personal injury or property damage. For safety, most RC flying fields have
formal frequency control rules. Follow them carefully.

Do not operate your radio control transmitter within 3 miles of a flying field. Even at a distance, your
transmitter can cause interference.

Do not operate radio controlled models and equipment in the rain, or at night.
Protect all electronic equipment from exposure to rain, water, high humidity and high temperatures.
FMA Direct recommends that you join the AMA. They can help you find a club in your area.

Academy of Model Aeronautics
5161 East Memorial Drive
Muncie, Indiana 47302

Phone: (800) 435-9262
Web: www.modelaircraft.org



What's included (and the other things you’ll need)

The FS Receiver bundle includes:

m FS Receiver.
m Viewer Software CD-ROM (not required for setting up and operating the receiver).

To use the receiver, you must supply:

m Crystal: FMA Quantum or Fortress series dual conversion, or Hitec dual conversion (on same channel
as your transmitter).

m FMA External Switch/LED Module (part number FSRES]1, for interacting with the receiver from outside
the aircraft).

m Battery pack: typically 4- or 5-cell NiCd. (Do not use alkaline batteries!)

Radio on/off switch harness.

m Servos.

Tip: Crystals, servos, aileron extension cables, switch harnesses,
Y-harnesses, battery packs, chargers and many other accessories are
available from your local FMA dealer or from FMA Direct

(www.fma.com).

To use the FS Receiver Viewer Software, you must supply:

m Desktop or laptop computer with:
e Windows 98 or a later Windows version.
e Serial port.
e CD-ROM drive.
e Microsoft .NET Framework software (if this is not already installed on your computer, you can install it
from the Viewer Software CD).
m FMA Failsafe Interface Module (part number FSIM1), which includes a 9-pin to 9-pin serial cable.



How the FS Receiver works

The FS Receiver combines the error catching advantage of PCM with the speed and interference tolerance
of PPM. (See PPM versus PCM for descriptions of these two approaches.)

A frame contains one set of data about your transmitter’s stick, switch and control positions. A radio control
receiver decodes this data and uses it to position the servos in your model. Unlike most receivers, when
the FS Receiver detects bad frames, it moves the servos to the last known position or moves them to
failsafe positions you preset, depending on the mode you set for each channel.

Digital Signal Recognition provides extensive error detecting and correcting to clean up the PPM signal.
The FS Receiver learns about your transmitter. When power is applied to the receiver, it determines the
transmitter type (positive or negative shift) and number of channels. If there is a power interruption in flight,
transmitter data is recalled from the receiver's memory. Glitches, for example, add false channels to those
already present in frames. By knowing the number of channels, the FS Receiver can throw out frames that
were shifted down one or more channels during a glitch. When the channel count is correct, bad frames
are detected when a servo position pulse is out of range. Valid servo pulses are 1 to 2 milliseconds

wide. If a channel commands the servo to move to 1/2 millisecond, for instance, the FS Receiver throws
out that frame.

When the receiver detects bad frames for about 1 second, it takes over control of the servos. This is called
a failsafe. You can judge how the radio system performed if you know how many failsafes and bad frames
occurred during a flight. After a flight, the receiver's LED blinks the number of failsafes since the receiver
was turned on. Then press the FS Receiver's button 3 times: the LED blinks the number of bad frames (up
to 99). If the Viewer Software is available, its History box lists the number of failsafes and bad frames
since the receiver was turned on.

The FS Receiver continuously performs 20 internal checks for memory and 1/O problems. This checking
repeats 100 times per second. If the receiver detects any corruption, it performs a system reset (which
takes less than 1/10 second) to restore operating parameters. This enables the FS Receiver to tolerate low
voltage brownouts without locking up. The Viewer Software lists and explains resets, if any.

As you can see, this tiny receiver is very powerful!

See also

PPM versus PCM

About FS Receiver modes

Digital Signal Recognition paper in the Support section at www.fmadirect.com.




About FS Receiver modes

As long as power is applied, the FS Receiver keeps the servo outputs energized. Unlike most receivers,
when the FS Receiver detects bad frames, it moves the servos to the last known position or moves them to
failsafe positions you preset, depending on the mode you set for each channel.

In Last Frame Hold Mode, the FS Receiver maintains the servo positions in the last valid frame from the
transmitter. This mimics the approach used in standard PPM receivers, except the servos maintain their full
torque. As delivered from the factory, all channels are set to Last Frame Hold Mode. You can also reset
the receiver to this state at any time.

In Failsafe Mode, loss of valid frames moves some or all the servos to positions you preset. The FS
Receiver enters Failsafe Mode after receiving statistically bad frames for about 1 second. At that time, all
channels with failsafe positions move to their preset positions, while channels without failsafe positions stay
where they are (as in Last Frame Hold Mode). When the FS Receiver detects 5 good frames in a row, the
receiver leaves Failsafe Mode and returns to Normal Flight Mode.

In Setup Mode, you tell the FS Receiver what to do when it receives bad frames. Using a simple
procedure (see Setting up the FS Receiver), you can set any channel to move to a preset position during
Failsafe Mode. Channels not set up for Failsafe Mode remain in Last Frame Hold Mode. The FS Receiver
stores setup information for each channel. It keeps this information even when power is turned off.

Normal Flight Mode is the receiver’s regular operating mode. Use Normal Flight Mode for testing, range
checking and flying your aircraft. If the receiver detects invalid frames, it automatically applies Last Frame
Hold or Failsafe presets to each channel. When valid frames are again received, the FS Receiver returns
to Normal Flight Mode.

See also
Setting up the FS Receiver
Operating the FS Receiver




Parts of the FS Receiver

Fin 1 [black or brown]  LED Buttan

Channel 1—g
FS Receiver
Antenna
Cryztal zocket White Fed wire
Connect External Switch/LED Module here
See also

Installing the FS Receiver




Installing the FS Receiver

To use the receiver, you must supply:

FMA Quantum or Fortress series dual conversion crystal (on same channel as your transmitter).
Battery pack.

Radio on/off switch harness.

Servos.

1. Insert the FMA Direct Quantum dual conversion crystal into the receiver’s crystal socket (see Parts of
the FS Receiver). Secure the crystal with tape or the included channel sticker.

2. Connect the FS Receiver just like any other receiver. Failure to observe correct servo/battery polarity
voids warranty. Damage may result to both receiver and servos.

Servoz

Channel 1

—

Battery Ondoff switch

Pirn 1 [black/brown] nest to edge

Servo connector orientation

Servo brand Pin1 Pin 2 Pin 3
Futaba Black Red White
Hitec Black Red Yellow
JR Brown Red Orange

Note: You cannot use “old style” (pre-“Z-type”) Airtronics servo
connectors with the FS Receiver. Use an adapter (FMA Part Number
217AJ) or convert “old style” Airtronics connectors to industry standard
configuration using FMA Part Number SEASSYJ.

Tip: Servos, aileron extension cables, switch harnesses, Y-harnesses,
battery packs, chargers and many other accessories are available from
your local FMA dealer or from FMA Direct (www.fma.com).

3. You must be able to press the receiver’s button and see the LED. If the receiver is mounted inside the
fuselage, you have two options:
m Access the receiver by removing the wing or a hatch. While possible, this is inconvenient, and
hinders preflight setup and post-flight feedback.
or
m Use the External Switch/LED Module. This accessory enables you to set up the receiver and “read”
the LED from outside the airplane.

To install the External Switch/LED Module:

a. Drill two holes, as shown at right, in the
fuselage near the receiver (on the side



opposite the engine exhaust).

b. Remove the button, nut and washer from
the switch.

c. Insert the switch and LED into the
fuselage holes.

Tip: It will be easier to see the
LED if it is above the button.

d. Secure the switch with the washer and
nut.

e. Press the button on the switch shaft.

Tip: Put a tiny drop of glue
inside the button to secure it to
the shaft. Be sure not to glue
the shaft to the housing!

f. Attach the External Switch/LED Module connector to the two pins between the crystal and the button
(shown in Parts of the FS Receiver).

4. Wrap the receiver in 3/8” or 1/2" foam rubber to protect it from vibration.

Note: Failure to use foam rubber to protect the receiver will void your
warranty.

5. Place the receiver in the fuselage and secure it to prevent movement.

6. Route the antenna so it is fully extended. Do not coil antenna, as this substantially reduces range. You
may cut antenna to as short as 18" without de-tuning the receiver. However, range will be reduced. Be
sure to range test and cut off a little bit at a time until antenna reaches desired length. (When installing
the receiver in a small airplane or a helicopter, see Special antenna installations.)

Note: Do not coil the antenna. Coiling will reduce the receiver’s range.



Setting up the FS Receiver

To do this... Do this...
Enter Setup Mode 1. Turn on transmitter.
2. With FS Receiver off, press and hold FS Receiver
button.

3. Turn on FS Receiver.
4. Release receiver button.

Receiver LED “twinkles” in Setup Mode. Servos set for
Last Frame Mode move slowly back and forth, servos set
for Failsafe Mode move to failsafe positions.

Set failsafe position for one channel While in Setup Mode:

1. On transmitter, move stick/control for that channel to

desired failsafe position (watch control surface or

throttle).

LED blinks the selected channel(s).

On FS Receiver, press button 1 time to save failsafe

position.

4. Return transmitter stick/control to neutral (or to idle for
throttle) before LED turns on.

whn

If mixing is programmed in your transmitter for the stick or
control, then this procedure sets failsafe positions for all
channels in that mix.

Set failsafe positions for multiple channels ~ While in Setup Mode:

1. On transmitter, move sticks/controls to desired failsafe
positions.

2. LED blinks the selected channel(s).

3. On FS Receiver, press button 1 time.

4. Return transmitter sticks/controls to neutral (or to idle for
throttle) before LED turns on.

Erase failsafe position for one channel While in Setup Mode:

1. On transmitter, move stick/control for channel you want
to erase.

2. Return stick/control to neutral (or idle for throttle).

3. Do not press button.

4. When LED turns on, the channel operates in Last Frame
Hold Mode.

5. LED blinks channel numbers just erased.

Erase all failsafe positions for all channels  While in Setup Mode: Press and hold FS Receiver button
for 2 seconds.

All channels now operate in Last Frame Hold Mode.
Determine a channel’'s mode While in Setup Mode:

Watch servos, control surfaces and throttle:

m Servos set for Last Frame Hold mode move slowly back
and forth.

m Servos set for Failsafe Mode are in preset failsafe
positions (and don’t move slowly back and forth).

Leave Setup Mode 1. Turn off receiver.
2. Turn off transmitter.



Checking radio system range

Range checking the FS Receiver is easier than other receivers. A failsafe condition will occur at the limit of
the range. The FS Receiver’'s LED shows whether a failsafe occurred during the range check. Just check
the LED after you return to the model.

Note: The usual way of finding the range limit by looking for servo

glitches does not work with the FS Receiver. Since the FS Receiver

actively responds to noisy or missed frames, servo glitches don’t occur.
Initial range check and range troubleshooting

1. Place the receiver on a non-metallic surface (a cardboard box, for example) to elevate it about 2 feet
(60cm) off the ground.

2. Fully extend the receiver antenna and position it vertically above the receiver (tape the antenna to a
wooden dowel, for example).

Connect one servo to receiver channel 1.
Fully collapse the transmitter antenna.

Turn on the transmitter.

o 0~ w

Connect a battery pack directly to the receiver. Do not use a switch harness for this test, since a switch
harness may reduce range.

~

Walk away from the receiver about 200 feet (60m) while moving the transmitter stick for channel 1.
8. KEEPING THE TRANSMITTER ON, return to the receiver and watch the LED:
m If the LED is still continuously on: there were no failures during the range test.
m If the LED is blinking, the range is less than 200 feet (60m).
9. Disconnect the receiver from the battery.
10. Turn off the transmitter.

Note: Over time, all RC transmitters are susceptible to detuning,
frequency drift and power reduction. If you suspect your radio system'’s
performance has degraded, carry out the rigorous range check with the
receiver out of the aircraft. If, under these conditions, the radio system
experiences failures, there may be a problem with the transmitter, the
FS Receiver or another part of the radio system. If you suspect the
transmitter is out of tune, FMA can tune it for you. With proof of
purchase for an FMA receiver, FMA will tune your transmitter (any
brand) at no charge. The only cost is for shipping.

Checking radio system range at the field

1. Fully collapse the transmitter antenna.

2. Turn on the transmitter, then turn on the receiver.

3. Walk 50 paces (about 150 feet or 45m) away from the model.

4. KEEPING THE TRANSMITTER ON, return to the model and watch the LED:

m If the LED is still continuously on: there were no failures, and the model remained under your control
during the range test.

m If the LED is blinking, the range is less than 50 paces. Find and fix the problem before flying!



Operating the FS Receiver

To do this... Do this...
Check for interference on your frequency 1. Turn on FS Receiver (leave your transmitter off).
2. Watch LED:

m One blink = frequency clear.
m Continuous blinks = interference on your frequency.

Enter Normal Flight Mode 1. Turn on transmitter.
2. Turn on FS Receiver.
Check receiver input voltage While in Normal Flight Mode:

1. While moving all transmitter sticks (to load radio
system), press FS Receiver button 1 time.
2. Count LED blinks:
m Each long blink = 1 volt.
m Each short blink = 0.1 volt.
(Example: 4 long blinks + 9 short blinks = 4.9 volts.)

Check radio system range While in Normal Flight Mode:

1. Collapse transmitter antenna.

2. Walk 50 paces (about 150 feet or 45m) away from
model.

3. KEEP TRANSMITTER ON and return to model.

4. Watch FS Receiver LED:
m Continuously on: no failures.
m Blinking: failures occurred.

For details, see Checking radio system range.

Check failsafe count after a flight or range 1. Keep transmitter on, keep receiver on!
check 2. Count LED blinks: each blink = 1 failsafe (maximum
report is 9 failsafes). No blinks = perfect signal.

Keep transmitter on, keep receiver on!

Press FS Receiver button 3 times.

Count LED blinks:

m Each long blink = 10 bad frames.

m Each short blink = 1 bad frame.

(Example: 2 long blinks + 4 short blinks = 24 bad
frames; maximum report is 99 bad frames)

Change between 1X and 2X LED flash rate Press FS Receiver button 5 times.
(1X =1 flash per second, 2X = 2 flashes per
second)

Check bad frame count after a flight or
range check

wh e

Clear failsafe count and bad frame count Turn off receiver.
(failsafe positions are retained)

See also
FS Receiver button summary




FS Receiver button summary

Button functions in Setup Mode

Do this...
Press and hold button, turn on receiver

Move transmitter stick(s) to servo failsafe position
for channel(s), press button, return transmitter
stick(s) to neutral (or low for throttle)

Press and hold button for 2 seconds

See also Setting up the FS Receiver

Button functions in Normal Flight Mode

Do this...
Don't press button

Press button 1 time

Press button 3 times

Press button 5 times

And this happens...
Receiver enters Setup Mode (LED “twinkles”).

Do not turn off transmitter during Setup Mode.

Receiver sets servo to failsafe position(s) for
channel(s).

For mixed channels, this sets failsafe positions for all
channels in mix.

Receiver sets all channels to Last Frame Hold Mode
(this removes Failsafe Mode servo presets from all
channels).

And this happens...
LED blinks number of failsafes (up to 9) since
receiver was turned on. No blinks = perfect signal.

LED blinks battery voltage (each long blink = 1 volt,
each short blink = 0.1 volt).

LED blinks number of bad frames (up to 99) since
receiver was turned on (each long blink = 10 bad
frames, each short blink = 1 bad frame). (Less than
30 bad frames indicates very clean signal during
typical flight.)

Change between 1X and 2X LED flash rate (1X =1
flash per second, 2X = 2 flashes per second).

Tip: When check for bad frames or changing blink rate, make each

button press before LED turns on.

See also Operating the FS Receiver




Installing the Viewer Software and Interface Module

To use the Viewer Software, you must supply:

m Desktop or laptop computer with:

Windows 98 or a later Windows version, and Internet Explorer 6.0 or later.

Serial port.

CD-ROM drive.

Microsoft .NET Framework software (if this is not already installed on your computer, you can install it
from the Viewer Software CD).

m FMA Failsafe Interface Module (part number FSIM1).

m 9-pin to 9-pin serial cable (recommended, but not required).

Note: For reliable operation, install the latest Windows updates.
Critical updates are on the Viewer Software CD, but Windows Update
is better.

A. Install the software
1. Insert the FMA Direct Viewer Software CD into the computer’s CD drive.
2. Use Windows Explorer to view the contents of the CD.
3. If Microsoft .NET Framework software is not already installed on your computer:
a. In Windows Explorer, double-click dotnetfx.exe.
b. Follow the on-screen instructions.
¢. For Windows 98 installations, reboot the computer.
4. Install the Viewer Software:
a. In Windows Explorer, double-click setup.exe.
b. Follow the on-screen instructions.
Note: Free software updates are available on the FMA Direct Web
site. See Software updates for details.
B. Install the Interface Module

The Interface Module connects the FS Receiver to your PC, and is required for using the Viewer Software
to view and record receiver data. (The Interface Module is not required for playing data files. For example,
you can play the demo data file using the Viewer Software to see what the program does. If you don't
already have an Interface Module, this demo file may help you decide to add one.)

1. For an FS5 receiver. Remove the servo connector from channel 1 of the receiver. Attach the Interface
Module servo connector to channel 1 of the receiver. Do not use a Y connector to attach the adapter
and servo at the same time.

2. Connect the Interface Module to the computer’s serial port using the serial cable included with the
Module.

Note: When you are finished using the Viewer, disconnect the
Interface Module from the receiver, and reconnect the servo to
channel 1.



Using the Viewer Software

1. Connect the FS Receiver to your computer's serial port using the Interface Module (see "Install the
Interface Module").

2. Turn on the transmitter, then turn on the FS Receiver.
3. Launch the Viewer:

m Double-click the Viewer icon on the computer’s desktop.
or

m Start > Programs > FS Receiver Viewer.

The program polls all the serial ports on your computer to find the one connected to the FS Receiver. If you
don’t see the display below after a few seconds, there is a problem in the connections between the
computer and the receiver. Check the cabling and connections. Make sure the black connector from the

Serial Adapter is in the proper orientation (black wire to the outside) on the channel 1 pins. See Parts of the
ES Receiver.

The Viewer provides real-time information about receiver operations. Here’s what's in the Viewer window:



Channel 1 dizplay

Channel 1 servo pozition

Channel 2 failzafe position

Current receiver mode

[Mormal Flight, Failzafe or Setup]

File | Wiew Help
| |
F=
¥ ¥ I ¥ ¥
-100 ] 100 -100 ] 100 -100 1] 100 -100 1] 100
Channel 1 Channel 2 Channel|3 Channel 4
¥ ¥
-100 ] 100 -100 ] 100
Channel & Channel b
NORMAL FLIGHT MODE
. |
History Status LED  FS Button
Failzafes = none B Ch. Futaba/Hitec ,l-n
Frarme Errors = none Battery = 1 b.33 Yolts Fipnare Yer.1.27
. _ . _ Copyright 2003 FA Direct
Min Batt = B.3v Signal =\ NEEN e, frnadirect. com
I I
MHurnber of failzafes, frame erors Current zsignal strength MHumber of Same as receiver LED
and mirimurn battery voltage at receiver transmi_tter channels [ondoff]
and shift type Same as receiver buthon

gince receiver was tumed on

Current battery voltage

[prezzeddnot pressed)



Using the Help Wizard

The unique Help Wizard provides a running description of what the FS Receiver is doing at any particular
moment. Additionally, the Wizard interprets the receiver’'s data for you, making it easy to understand what
the receiver is telling you.

To open the Help Wizard: Help > Help Wizard, or press F1. Here's what's in the Help Wizard window:

Test denamically describes receiver Cloze window
ghatuz and interpretz data b ode Print text currently
Arctivate far brief repart [Marmal Flight Mode ar Setup Maode] it thig wirdow

F hll HORMAL FLIGHT MODE
1 Sumrmary

Dire

Mane of the channels are pragrammed for failsafe. Last frame hold is an channel 1,2, #
3,4, 5 and B

F= RECENER BUTTOMN: Press the FS RHeceiver button once to show the battery
voltage. Each lang pulse represents 1.0 volt, and each short pulse represents 0.1
volt. Pressing the button now will display 6 long and 3 shoart pulses. That is 6.3
“olts. The LED flash rate is one second. [fthis is too slow, press the FS Heceiver
button & times to speed up to 1/2 second flashes. This setting is saved until you
change it.

SIGMAL CUALITY: The FS Receiver's bad frame counter is wery accurate. |t tells
precisely how many frames were received that had too much noise to be carrected.
The FS Receiver iz currently receiving 55 frames per second. 1 bad frames were
detected. Most flights will have some bad frames. This flight had a total of 0.02
second(s) of bad reception, which you probably didn't notice. Press the F= Receiver
button 3 times ta view 1 bad frames on the LED.

FAILSAFE HIZSTORY: Mo failsafes occurred. The LED shows this by stayigg OB,

L
Click argwwhere within window to freeze or unfreeze text Scroll or resize window
[new recerver data is ignored when window iz frazen) to zee more information

Tip: Before printing the Help Wizard, use the File > Print Setup
command to select a printer and set printer properties.

Tip: While the Help Wizard text is frozen, it ignores receiver data, so
you might miss critical events. Instead, you can record receiver
operation (see Recording and playing a data file), then play back the
data file. During playback, open the Help Wizard for data
interpretation. Instead of freezing the Wizard, click the Pause
button. This enables you to read all operating details.




Recording and playing a data file

The Viewer Software has a built in Recorder/Player that records real-time data from your FS Receiver and
stores it in a file. The Recorder logs all incoming data and adds time information. The Player plays back,
or steps through, the entire file.

Flayback :peed
Player index slider Add nate tofile

Dﬂ#ﬂ Recorder ”':'il

Times= 22 550 2| 1734

II DERO.FSR
F'Ia_l,l Heu:-:uru:l Current file
Pauze Stop

Recording can be helpful for range checking. It will play back exactly what the receiver was doing during
the range check. Since the FS Receiver doesn't respond to glitches like a conventional receiver, you can't
tell where the transmitter’s range ends by looking at the model’s control surfaces. Recording can also be
helpful in getting technical support. You can send the recorded data file to FMA Direct for analysis by
attaching it to an e-mail message (see Sending a data file for analysis).

Recording logs all incoming data from the FS Receiver. Recording can be paused or stopped. If you
record to an existing file, the new data is appended to the end of that file.

Playing recreates FS Receiver operation from a data file. Time is shown in the Recorder time index
window. During playback, data sent by the FS Receiver to the serial port is ignored. The 2x/1x button
changes the playback speed (however, some computers may play back in only one speed).

Pausing stops the Viewer on one line of data. Data from the FS Receiver is ignored during this
time. Playback remains paused until you move the play index slide bar, or resume play. To step through
the data file one line at a time, click the index bar, then press the left/right arrows.

Tip: Load and play the demo file to see how notes are used to identify
what the Viewer is doing.

To do this... Do this...

Prepare for data recording 1. Disconnect servo from channel 1 on FS Receiver.
Connect Serial Adapter to channel 1 on FS Receiver.
Connect Serial Adapter to PC serial port.

Launch Viewer.

Turn on transmitter.

Turn on FS Receiver.

File > New.

Name and save the file.

Click Record button.

Carry out any transmitter or receiver actions you want to
record.

5. When done, click Stop button.

6. To save data, File > Save / Close.

Record data

PwNPE o~

Stop recording or playback Click Stop button.
Pause recording or playback



Pause recording or playback
Open data file

Play back current data file
Move to any point in current data file

Add note to current data file

Click Pause button.

File > Open Data File.

or
In Windows Explorer, double-click an FSR file. (File will
begin to play immediately in Viewer.)

Click Play button.

1. Click Pause button, then...
2. Drag player index slider.
or
Use right-arrow and left-arrow buttons to move through
file one line at a time.

While data file is open:

1. Drag player index slider to place where you want note.
2. Click Note button (or press ALT-N).

3. Type note.

4. Click Save button (or press ALT-S).



Keyboard shortcuts

To do this... Press this key or combination...
Open Help Wizard F1

Open help file (contents tab) ALT-F1

Open help file (index tab) ALT-F2

Open data file CTRL-O

Save/close data file CTRL-S

Start new data file CTRL-N

Open or close Recorder/Player CTRL-R

Tip: Each menu and command has a keyboard shortcut. For example
ALT-F-X is the shortcut for the File > Ex



Frequently asked questions

General information

Q:
A:

Will the FS Receiver prevent my airplane from crashing?

No. The FS Receiver can only move your airplane’s control surfaces and throttle to preset positions
when it doesn’t receive a clean signal from your transmitter. This may keep your airplane flying long
enough for you to find and correct the problem.

: Can | use the FS Receiver with all types of airplanes?

A: Yes, with some caveats:

m For planes that return to straight and level flight when you release the transmitter sticks (e.g., trainers,
many high-wing planes): assign Failsafe Mode presets for the throttle and primary control
surfaces. Use Last Hold Mode for other channels.

m For aerobatic planes (which continue where pointed when you release the transmitter sticks) and
helicopters: use Failsafe Mode for the throttle and Last Hold Mode for all other channels. Since an
aerobatic aircraft doesn’t return to straight and level flight on its own, failsafe presets for the control
surfaces can't put it into a stable attitude during an extended interruption of the transmitter
signal. However, you still get other benefits from using the FS Receiver: error detection, error
correction, high noise tolerance, failsafe count and battery voltage readout.

Q: Can | use the FS Receiver with the FMA Direct Co-Pilot flight stabilization system?

A:

Yes. In fact, this approach is recommended for aerobatic aircraft. If the transmitter signal is interrupted,
Co-Pilot helps the airplane return to a stable attitude, while the FS Receiver moves the servos to failsafe
or last frame hold positions. Using the FS Receiver with Co-Pilot provides full-function failsafe. If radio
contact is lost, Co-Pilot will stablize the aircraft. Set failsafe positions for low throttle and some rudder,
and the aircraft should go into a flat, low-speed turn from any attitude. With some adjustments to the
failsafe settings, and if the aircraft doesn't encounter an obstruction, it may actually land with little or no
damage.

Note: If you are using a channel for on/off control of Co-Pilot, set the
failsafe for that channel so that Co-Pilot is on.

Setting up

Q:

I can’t take my computer to the flying field. How do | set up the FS Receiver without the Viewer?

A: You can set all FS Receiver functions without the Viewer Software. You interact with the receiver

through its button and LED, and you set failsafe positions using your transmitter sticks. Details are
provided in Setting up the FS Receiver and Operating the FS Receiver.

Q: What are good failsafe preset servo positions for an airplane?

A: The best failsafe preset servo positions will depend on your particular aircraft and how it behaves in the

air. A reasonable starting point for flight-stable airplanes is:
Ailerons: neutral.

Elevator: neutral.

Rudder: moderate right turn.

Throttle: 1/3 to 1/2.



You'll need to test these settings and adjust them as needed. Your goal is to have the plane circle and
gently descend, without stalling, during a failsafe condition.

Q: My airplane has flaps and/or retractable landing gear. What about failsafe presets for those?

A: Since flaps can slow the airplane, deploying them (with some rudder failsafe preset) may help keep the
airplane close to the field. It's probably a good idea to drop the landing gear, although for some
airplanes a belly landing may be less costly than bent landing gear.

Q: How do | test failsafe operation?

A: First, do a check on the ground:
1. Turn on your transmitter, then turn on the FS Receiver.
2. Move the transmitter sticks to make sure the aircraft controls respond correctly to your commands.
3. Turn off the transmitter and watch the airplane’s control surfaces and throttle:
m For channels with failsafe presets, the servos should move to their preset positions.
m For channels without failsafe presets, the servos should remain where they were (last frame hold)
when you turned off the transmitter.

If the radio system works properly, try forcing a failsafe condition in the air:
1. Take off and gain altitude until the airplane is at least three mistakes high.
2. Put the plane into straight and level flight at 3/4 to full throttle.
3. Turn off the transmitter for 2 to 3 seconds, THEN TURN IT BACK ON.
m While the transmitter is off, watch how the plane responds.
m Be prepared to correct the plane’s attitude as soon as you turn the transmitter back on.

If necessary, land the airplane, change the presets, and test again on the ground and in the air. Be
sure to avoid settings that would stall the airplane.

Q: Do I have to set up the FS Receiver before each flight?
A: No, the receiver stores setup information even when power is off. However, it's a good idea to test
failsafe operation on the ground (by turning off the transmitter) as part of your usual preflight checks.
Flying
Q: What can cause the FS Receiver to enter Failsafe Mode?
A: There are several possibilities:
m You accidentally turned off your transmitter.
m Your transmitter batteries are depleted.

m Someone else turned on a transmitter on your channel.
m There is radio interference from some unknown source.

: When my airplane is flying, how do | know the FS Receiver is in Failsafe Mode?

O

>

. Move the transmitter sticks. If the airplane doesn’t respond, the receiver is in Failsafe Mode.

: What should I do if the FS Receiver goes into Failsafe Mode?

> O

AWM R

. IMMEDIATELY WARN OTHER PILOTS AND SPECTATORS.

Make sure your transmitter on/off switch is on.

Check your transmitter’s battery status.

Ask other pilots if anyone turned on a transmitter on your channel. If someone did, tell them to turn
off their transmitter immediately.

If you are unable to regain control of the aircraft, keep it in sight and continue warning everyone in

o



the area.

Q: What happens if the FS Receiver goes into Failsafe Mode and | can't find/fix the problem.

>

Ideally, your preset failsafe servo positions will put the airplane into a stable attitude that will allow it to
circle and descend slowly to the ground. Because you can't control the plane, expect a hard
landing. That, however, is much better than the plane drilling itself into the ground, or flying out of sight.

Q: My FS Receiver usually records a dozen or two bad frames during flights. Is that bad?
A: No. Infact it indicates your radio system is performing very well. Occasional glitches are common. It

takes at least 50 consecutive bad frames to cause a failsafe condition. Bad frames are an indirect
measure of signal quality and receiver performance.

Q: What happens if the receiver battery dies during a flight?

>

: Sorry, the FS Receiver can't help with that problem. To avoid that situation, check the receiver battery
with an extended scale voltmeter before every flight.

Q: I accidentally turned off the Failsafe receiver before | “read” the bad frame count by pressing the button
three times. Can | get that information later?

A: No. The bad frame and failsafe counts are lost when you turn off the receiver.

Viewer
Q: | have a 4 channel transmitter, but the Viewer says it has five channels.
A: RC radio manufacturers sometimes use one circuit board in multiple transmitter models. In your case,

they put a five channel circuit board in a four channel housing. The transmitter outputs a five channel
signal, but doesn’t give you a way to control the fifth channel.

Q: Can I use the Viewer Software with other receivers?

A: No. It only works with advanced receivers from FMA Direct.

Q: The Viewer suddenly shows a lot of information I've never seen before. What's that all about?

A: You've discovered the normally-hidden Technical Display (see below). It provides details beyond what
you need to know for normal operation, but it may be useful for troubleshooting. To hide the Technical
Display (or show it later), click the title ("Status") in the Status box.

Swnc Pulse = 733005 Fiec Fesponze= 17T mE
Start Bit = 441 u% Button ADC= 189
Frame= 12.1m% W Ref ADC = 407
2nd Tx= 1 Searching 5% Low AbC= 134
Serial Errors = none Servo Moise= 1ul
bdzin Loop = - System Fesets = none
Telemetry = - Good Frm CHT= 255
Ch Rejected= - - - - - -
7 BOm=s © 1Z¥ms Signa| = 4| dE M
Short Swo Errars = 0
Lang Swa Errars = 0



Special antenna installations

Small aircraft

If you are installing the FS Receiver in a small aircraft, you may need a shorter antenna. You may cut off
part of the antenna without detuning the receiver (a unique feature of FMA Direct receivers). However,
reducing antenna length will reduce range.

Proceed carefully! Remove only a small portion of the antenna at a time, then range check the radio
system on the ground after each reduction in length.

Never cut the antenna shorter than 18” (50cm).

Helicopters

Helicopters generate radio frequency noise and heavy vibration. Here are some tips for improving
reception in a helicopter:

m Route the antenna as far away from the tail boom as possible. This is particularly important for
helicopters with carbon fiber booms.

m Mount a plastic tube (nylon pushrod tube, for example) on the skids and route the antenna through it.



PPM versus PCM

PPM stands for Pulse Position Modulation. In this approach, each servo position is encoded by a specific
pulse width. Pulse width for one channel ranges from 1 to 2 milliseconds. A 6 channel transmitter will
generate 6 pulses in the output signal. The receiver knows what pulse is servo 1 because of a long sync
pulse that lasts 5 milliseconds. A glitch occurs when a stray pulse is introduced to the signal. Suppose a
stray 0.1 millisecond pulse occurs in the channel 4 pulse. Servos 1-3 would be positioned correctly, while
servo 4 would move to an incorrect position. The glitch gets worse when the receiver shifts channels 4, 5
and 6 down one position because of an extra pulse. The position of channel 5 is now given to servo 6,
while servo 6 goes to the empty slot for servo 7. After a single glitch, correct servo positions are restored in
the next frame. The 1/50th second wait for the next frame causes little movement of a servo. Since
glitches are random, the odds are greater for glitches on the servos connected to higher channel
numbers. That is why important control surfaces are on channels 1 and 2.

Standard PPM receivers have some tolerance for noise. Most of the time, only half the servos receive a big
glitch. Smaller glitches will not shift the servos at all. When just one servo shakes a little, a small glitch
delayed the pulse on its channel.

PCM stands for Pulse Code Modulation. In this method, control positions are converted to 10 bit binary
numbers before transmission. Each channel requires 10 pulses to represent the numeric position. A glitch
in this data stream can dramatically change the positions of all servos on channels following the

glitch. However, to keep the numbers readable by the receiver, the transmitter calculates and sends a
cyclic redundancy check (CRC) number. The CRC number is recalculated in the receiver and checked to
see whether it matches the received channel data. If one or more bits are corrupted, the entire frame is
thrown out. This is known as error detection. The PCM receiver then waits for the next clean frame before
updating the servos. In a PCM radio system, moderate noise can corrupt several frames in a row.

Individual pulses are much shorter for PCM because there are so many of them. The higher number of
pulses per frame slows down the frame rate. A 6 channel PCM frame will have at least 72 pulses in a
frame. One delayed or changed pulse among the 72 will corrupt the entire frame. This is why PCM
receivers can lose control and go into failsafe mode. To make things better, some PCM transmitters break
up a 6 channel frame into two frames of 3 channels each. This way, only half the channels will be affected
by a discarded frame.

When it comes to glitches, PCM receivers are better then PPM receivers because they catch all
glitches. The CRC will never let a glitch through to the servos. On the down side, a PCM receiver will
discard an entire 5-channel frame if it finds 1 bad bit among the 50 data bits. In comparision, if a PPM
receiver encounters 1 bad pulse in 50, it still has four good 5-channel frames to work with.

The FS Receiver combines the advantages PCM (error detection and high noise tolerance) and the
advantages of PPM (faster and more tolerant of glitches) to create a higher level in receiver performance. It
also adds a new feature to receivers called Digital Signal Recognition (for details, see How the FS
Receiver works).



Sending a data file for analysis

The Viewer Software shows every detail of the FS Receiver’s operation. If you suspect something is not
functioning properly, you can send a sample Viewer data file to FMA for analysis. Follow these steps to
send a sample data file:

1. Click File > New and change the directory to C:\. This will make the data file easy to find when you send
it.

2. Use the default name Datalogl. Click Save to create the data file.

3. Turn on the transmitter, then turn on the FS Receiver.

4. Make sure the FS Receiver is communicating with the PC by moving the transmitter sticks. If you don’t
see activity in the Viewer window, fix the problem before continuing. Be sure the receiver is powered up
and is connected to the PC'’s serial port with the adapter cable.

5. In the Viewer window, click the red Record button.

6. If there is a setup problem, try to show it in the Viewer while recording the data log. If there is a range
check problem, then do a range check while recording the data log. (You don’t need to be outside to
perform a range check.)

7. When you have recorded the problem, click the Stop button.

8. Try to explain the problem in an e-mail message, or better yet, insert notes into the data file. To insert
notes, play back the data file and pause where you want to insert the note. Then click the Note button,
type the note and click Save.

9. When you are done, click File > Save / Close, or just exit the Viewer.

10. Launch your e-mail program and create a new message addressed to support@fmadirect.com. In
the message, include any information that would be helpful in diagnosing the problem.

11. Add the data file C:\Datalog1l.FSR to the message as an attachment. (To insert an attachment in an
Outlook message, for example, use the Insert > File... command.)

12. Send the message.

FMA Direct technical specialists will examine your data log and respond as soon as possible.



FS Receiver quick start

CAUTION: These instructions leave out a lot of details that help you
understand and use the receiver. Click the links for more information.

What it does: When the FS Receiver stops getting a signal from the transmitter, it moves the servos to
preset positions. Where the servos move depends on how you set up each channel in Setup Mode. (See
How the FS Receiver works.)

Modes (see About FS Receiver modes):

m The FS Receiver has two operating modes: Setup Mode (where you tell it what to do) and Normal
Flight Mode (for flying).

m When the receiver doesn't get a good, clean signal from the transmitter, it puts each channel into
Failsafe Mode (servos go to positions you set) or Last Frame Hold Mode (servos stay where they were
during last good signal). You tell the receiver which type you want in Setup Mode.

Installing. Install the receiver pretty much like any other. (See Parts of the FS Receiver and Installing the
ES Receiver.)

1. Plug in crystal, servos and battery/switch harness. Servo channel 1 is farthest from crystal. Black or
brown wires on servo/battery connectors go toward outside. Failure to observe correct servo/battery
polarity voids warranty. Damage may result to both receiver and servos.

2. Different: External Switch/LED Module (installation optional, but recommended) lets you interact with
receiver from outside aircraft. Mount module in holes in fuselage, then plug it into receiver on pins
between button and crystal (white wire toward servo connectors).

3. Wrap receiver in foam rubber and secure in aircraft. Failure to protect receiver voids warranty.

4. Route antenna. Do not coil antenna, as this substantially reduces range. You may cut antenna to as
short as 18" without de-tuning the receiver. However, range will be reduced. Be sure to range test and cut
off a little bit at a time until antenna reaches desired length.

Setting up (see Setting up the FS Receiver)

1. Enter Setup Mode: Turn on transmitter, press and hold receiver button while turning on receiver. LED
"twinkles" in Setup Mode. Servos set for Last Frame Mode move slowly, servos set for Failsafe Mode
move to failsafe positions (and don't move after that).

2. Set a channel for Failsafe Mode: Move transmitter stick to desired failsafe position, press receiver
button, return stick to neutral (or idle) before LED turns on. Repeat for other channels. Channels in a
mix are set at the same time. If not set for Failsafe Mode, channel is automatically in Last Frame Hold
Mode.

3. Leave Setup Mode: Turn receiver off. Receiver retains settings even when power is off.

Checking failsafe operation on ground
1. Turn on transmitter, turn on receiver.
2. Turn off transmitter. Receiver moves servos to failsafe/last frame positions.

3. Turn on transmitter. Receiver LED blinks, indicating a failsafe occurred.



Checking range at the field (see Checking radio system range for initial testing and troubleshooting)

(Because the FS Receiver corrects for occasional glitches, you can't check range by watching for jittering
control surfaces.)

1. Turn on transmitter, turn on receiver.
2. Collapse transmitter antenna, walk 50 paces away from model.

3. Different: Keep transmitter on, return to model and look at LED:
m If LED is on steady, there were no failsafes. Radio system passed range check.
m If LED is blinking, failsafes (loss of good signal) occurred. Find and fix problem before flying.

Using (see Operating the FS Receiver and FS Receiver button summary)

m To check for other transmitters on your frequency: Turn on receiver (leave your transmitter off) and
watch LED: 1 blink = frequency clear, or continuous blinking = interference.

m To check battery voltage: While moving transmitter sticks (to load system), press receiver button 1 time,
then count LED blinks (long blink = 1 volt, short blink = 0.1 volt).

m Fly like you normally do. If receiver loses signal, servos go to failsafe presets or stay at last good
position.

m Optional: After flight, keep transmitter and receiver on. Review flight history:
e If LED is blinking, number of blinks = number of failsafes during flight.
e Press receiver button 3 times, count LED blinks to determine number of bad frames during flight
(each long blink = 10 frames, each short blink = 1 frame). Less than 30 bad frames indicates a very
clean signal during flight.



Viewer Software quick start

What it does: The Viewer Software provides real-time information about the receiver, its failsafe settings,

battery voltage, transmitter type, signal strength and failsafe history. It can also be used to record and play
files containing this data. Although the Viewer is not required to set up and use the FS Receiver, it can be

helpful for troubleshooting. If installed on a laptop computer, the Viewer can be used at your flying field.

Installing (see Installing the Viewer Software and Interface Module):

1. Put FMA Direct Viewer Software CD in your computer's CD drive.

2. If Microsoft .NET Framework software is not already installed on your computer, launch dotnetfx.exe on
CD. Follow on-screen instructions.

3. Launch setup.exe on CD. Follow on-screen instructions.
4. Connect Interface Module to channel 1 of FS Receiver, in place of servo.

5. Connect Interface Module to serial cable, then connect serial cable to computer's serial port.

Using (see Using the Viewer Software):

1. Turn on transmitter, turn on receiver.
2. Launch Viewer.

For an interpretation of Viewer data: Help > Help Wizard (see Using the Help Wizard).

To record or play data files, open Recorder: View > Data Recorder (see Recording and playing a data file

).




Software updates

Viewer Software updates are available in the Support section of the FMA Direct Web site.

Note: You don't need to uninstall the previous version. The installer
will overwrite the version currently installed on your computer.

1. Click here: Support.
or

Use your Web browser to open www.fmadirect.com/site/fma.htm?body=Support .
Scroll down the Support page to find the Software Updates section.
Click the link for the latest Viewer Software version.

In the File Download window, click the Open button.

a > 0NN

Follow the on-screen instructions.



Technical support and contact information

FMA Direct
5716A Industry Lane
Frederick, MD 21704 USA

Web: www.fmadirect.com

Product manuals and software updates are provided in the Support section of the FMA Direct Web site.

For technical support:

Telephone: (301) 668-7614
E-mail: support@fmadirect.com

See also

Software updates
Frequently asked questions

For sales information:

Telephone: (800)-343-2934
E-mail: sales@fmadirect.com
Fax: (301) 668-7619



FMA, Inc. warrants this product to be free of manufacturing defects for the term of one year from the date of
purchase. Should any defects covered by this warranty occur, the product shall be repaired or replaced
with a unit of equal performance by FMA, Inc. or an authorized FMA service station.

Limits and exclusions. This warranty may be enforced only by the original purchaser, who uses this
product in its original condition as purchased, in strict accordance with the product’s instructions. Units
returned for warranty service to an FMA service center will be accepted for service when shipped postpaid,
with a copy of the original sales receipt or warranty registration form, to the service station designated by
FMA, Inc.

This warranty does not apply to:
m Consequential or incidental losses resulting from the use of this product.

m Damage resulting from accident, crashes, misuse, abuse, neglect, electrical surges, reversed polarity on
connectors, lightning or other acts of God.

m Damage from failure to follow instructions supplied with the product.

m Damage occurring during shipment of the product either to the customer or from the customer for service
(claims must be presented to the carrier).

m Damage resulting from repair, adjustment, or any alteration of the product by anyone other than an
authorized FMA technician.

m Installation or removal charges, or damage caused by improper installation or removal.

Call (301) 668-7614 for more information about service and warranty repairs.



Viewer Software version

To determine the version of your Viewer Software: Help > About.
This Viewer is written in Microsoft Visual Basic.NET. Source code is available for language translation.
Copyright 2003 FMA Direct.

6/6/2003
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